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About This Manual
Thank you for purchasing Goldenseal!

This start up manual shows you how to use the estimating features in
Goldenseal.

This manual is a companion to the Getting Started With Goldenseal Basics
manual. It’s a good idea to look at the first few lessons in the Basic manual
first, since they contain information about many basic Goldenseal features
which are also used in the estimating parts of the program.

NOTE: We make frequent improvements to Goldenseal, so there may be
minor differences between the screen shots in this manual and the
actual program.

Getting Help
Goldenseal includes unlimited free email and telephone support for as long
as you use the software. Send email to support@turtlesoft.com, or call us at
(607) 272-1008 during our office hours.

We also offer many support options on our website at www.turtlesoft.com.
Click the Answers button for an alphabetical listing of special topics, where
we have specific instructions for many situations.

HINT: It is much easier for us to keep the website up to date, so new
features are often described there before we can get them into the
printed manuals.

Goldenseal Estimating Manual Page 1



Table of Contents
Advanced Topics

Before You Begin........................................................4 Custom Proposal Forms...................................................158
Estimating Basics......................................................6 Creating New Unit Prices.................................................
Types of Estimates...................................................... Import Starter Data..........................................................161

Index.................................................................................168

Estimating Basics
Lesson 1 Estimating Setup........................................8
Lesson 2 Estimate Records.....................................10
Lesson 3 Simple Estimates......................................12
Lesson 4 Category Breakdowns..............................15
Lesson 5 Item Breakdowns.....................................18
Lesson 6 Printing Estimates....................................24
Lesson 7 Estimate Dimensions...............................26
Lesson 8 Room Dimensions....................................29
Lesson 9 Awarding Estimates................................31
Project 10 Schedules....................................................
Lesson 11 Bids........................................................34
Lesson 12 Allowances.................................................
Lesson 13 Project Phases............................................
Lesson 12 Bill of Materials / Material Takeoffs....45
Lesson 13 Calibrating Prices.......................................
Lesson 14 Updating Material Prices.......................86
Using Cost Items & Assemblies..................................

Page 2 Table Of Contents Table Of Contents Page 3



Before You Begin • Cost Categories— Goldenseal uses Cost Categories and Category
Systems to group the line items in your estimates. They’ll help you to
put together an estimate more quickly. Lesson 5 covers them.

Before you start using Goldenseal, you’ll need to install the software, and
set up a company file. • Find Commands— Dealing with hundreds or thousands of unit costs

can be overwelming! The Find commands will help you to locate
individual costs, or small groups of costs. There’s more about it in
Lesson 9.Installing Goldenseal

• Printing— Most likely you’ll want to print up a proposal for your
clients. Goldenseal includes a half dozen different proposal forms you
can use for that. Lesson 11 explains how to print from Goldenseal.

If you haven’t already installed Goldenseal, follow the instructions on page
5 of the Basics manual. You can install from the CD, or from a website
download.

• Reports— Sometimes it helps to see your information in condensed
form. Goldenseal reports do that for you, and there’s more about
them in Lesson 12.Setting Up a Company File

If you just want to practice with Goldenseal before using it for your
business, start out by using the Sample Company File (see Lesson One in
the Basics manual). It includes some data for a fake company, so you won’t
need to do any setup before using the Goldenseal features.

• Customizing Goldenseal— You may want to change the appearance
of printed forms, reports, or data entry screens. Goldenseal includes a
Custom Layouts command that lets you do that. You can see more
about it in Lesson 16.

• Templates— once you have created some estimates, you may want to
re-use them for other projects that are similar. To do that, you’ll
create a template. More about them in Lesson 19.

When you are ready to start using Goldenseal for your business, set up a
new company file from one of the starter files. Instructions for that are on
page 10 of the Basics manual.

How to Use this Manual
HINT: There are several starter files with unit prices for different types
of construction. The Construction Starter File includes all types of
construction costs.  Other starter files include a smaller selection of
prices for specific subcontractors. There are also general starter files for
retail and service businesses, with no unit costs included.

We suggest that you read through each lesson while you are at the com-
puter, and actually try each feature while you are reading the lesson. Things
will ‘sink in’ better that way.

Goldenseal Basics
If you have time and want to see everything that is in Goldenseal, work
through all the chapters (you can skip any chapters that apply to features
that you don’t plan to use).Many basic Goldenseal features are covered in the separate Basics manual.

If you haven’t looked at that yet, you might want to try out a few of the
Lessons there, so you can become more familiar with the way Goldenseal
works.

If you are in a hurry, just look at the features that you want to use right
away.

If you already have experience with other computer programs and with
paper estimating, you can probably get through each lesson in just a few
minutes.

This manual covers only the estimating features. You’ll get much more out
of Goldenseal if you also understand the many basic features of the
program. Here are some key features, and their location in the Basics
manual: HINT: You may find it helpful to take a break after each lesson, so you

can absorb the new information. Close your eyes for a bit, have
something to eat, and let the thoughts solidify into ‘estimating crystals’
in your brain.

• Data Entry— Goldenseal stores information in records, each
containing fields with different ‘pieces’ of information about that
item. Lesson 2 in the Basics manual covers that.
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Estimating Basics Estimating Terms
Different people use different terms for project estimates— you may call
them bids, estimates, proposals, quotations, or some other name that is
commonly used in your industry and/or region.

Goldenseal is a project estimating program that helps you to calculate what
it will cost to do construction work, or other types of projects.

For consistency, Goldenseal uses two types of estimating records:To save time and increase accuracy, you can use Assemblies to calculate
unit costs for the specific work you’re doing. For non-standard work or
small jobs, you can also type in project details, without using unit costs.

Bids— for price quotes that you get from a supplier or subcontractor.
Estimates— for price quotes that you give to a customer or client.

Unit Cost Basics
HINT: When you print proposals to give to a client, you can call the
estimate whatever you want. To do that, use the Custom Layouts
command to change the title text in the Printed Form that you give to
the customer (see Lesson •• in the Basics manual).Goldenseal includes a complete system of unit costs, which make it easy to

arrive at a highly accurate cost estimates, very quickly. You don’t need to
use unit costs, but you’ll probably find that they increase both the speed
and accuracy of your estimates. Goldenseal unit costs come with “fringe
benefits”, since they also give you a material list, schedule, tool list and
contract, after you have finished an estimate.

Creating Estimates
Creating an estimate in Goldenseal is usually a five step process:

1. Create a new estimate record.
Goldenseal includes two different types of unit costs: HINT: If you make the estimate from a template, it will start out

with most of the items you’ll need for the project.Cost Items— the cost of different types of labor, and the cost of materials
that you use on projects. 2. Enter measurements for the project (optional).

Assemblies— the cost of each type of work that you do on a project. The
cost of an Assembly is calculated from a list of components, with the
quantities you need for each. Usually an Assembly will include both
labor and materials.

3. Add calculated ‘line item’ quantities for the project, or adjust the ones
included in the template.

4. Add allowances, bids, and any unusual items (optional).
5. Print out a proposal form for the client.

Each unit cost includes a cost per some type of unit— which may be a
square foot, a lineal foot, a piece, or whatever other type of measurement
that makes sense. How Long will an Estimate Take?

If an estimate is simple, or similar to projects you have done before, you
can probably produce a finished estimate in just a few minutes.

• For labor Cost Items, the unit is usually one hour.
• For material Cost Items, the unit is a purchase unit— which may be a

piece, a length, an area, a weight, a volume, or some other measure.
For example, plywood is sold by the piece, while concrete is measured
by the cubit yard (cubic meter in the metric version).

If the project is large or unusual, you may spend hours checking details
from the plans or specifications, and entering unit costs and quantities into
your Goldenseal estimate.

• For Assemblies, the unit is an installed measurement— which may be a
piece, a length, an area, or some other unit that is easy to measure off
a set of plans. For example, plywood subfloor is measured by the
square foot (sq meter in metric), while wall framing is measured by the
lineal foot (meters in metric).

If the project is different from any of our estimating templates, it may take
some extra time, since you will need to set up the specific line items of work
needed to complete the job. However, once you have done that, you can set
up that estimate as a template so you can easily reuse it on future projects
that are similar.

Goldenseal comes with several Starter Files which include unit costs for a
specific type of work. Costs are available in both US and metric units.
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Types of Estimates If the work is similar in all the rooms you’re working on, you can enter
project dimensions (see Lesson ••) and have Goldenseal calculate most
quantities for you. If the work is different in each room, enter Estimate
Locations (see Lesson ••) and calculate work quantities on a room-by-
room basis. For some projects, it works best to use both types of
dimensions (for example, you can use project dimensions for the main part
of the work, and then do additional items on a room-by-room basis).

Goldenseal includes a variety of tools that will help you to build many
different types of estimates. The basic approach you’ll use depends on the
way you run your business, and the type of project you’re estimating.

This section covers some of the most common cases where you might use
Goldenseal estimating.

New Construction
Remodeling may require extra line items for repairing deficient structures,
matching existing styles or materials, or dealing with the many possible
surprises that may occur. You can reduce your risks by including a ‘hidden
conditions’ clause in your contracts, so you can charge for extra work
resulting from problems not visible in the initial inspection.

If you are building with your own crews, use an Item breakdown (see
Lesson ••) and start from a new construction template (see page 25).
You’ll enter project dimensions (see Lesson ••), and then adjust any
details that are different from the ‘stock project’ described in the template.
If you subcontract some work, you’ll enter them as Bids (see Lesson ••). General Contractors and Developers
If you are a developer who subcontracts more or all of the work, you may
want to enter most items as Bids (see the section for General Contractors
on the next page).

If you are hiring subcontractors and won’t be doing any of the work
directly, your estimates will be just a list of Bids that you receive from
suppliers and/or subcontractors (see Lesson ••).

If you build the same plans frequently, you can set up each model as a
template, and get an estimate very quickly. You can enter ‘options’, and
then add or remove them from the project very quickly (see page ••).

You can still use assemblies for rough estimating, for any work done by you
or your crews, and for materials that you purchase for your subcontractors
(use Assembly Materials instead of an Assembly when the labor is subbed
out). You will also add markup to the bid prices, usually with a line item
calculated as a percent of hard costs.Room Additions

Exterior Work— Roofing, Painting, Siding, Concrete, Etc
If you are adding to an existing building, your estimates will start out
similar to new construction estimates (although some costs may be higher
because of the smaller size, and more awkward working conditions). You’ll
probably need to add extra work at the connection between the new and
old structures. That part of the project is similar to remodeling, and is
usually best handled by entering room dimensions (see Lesson ••) for any
work in the existing building.

Exterior specialty work is easier to estimate, since it requires fewer line
items. You can probably put together something like an exterior painting
estimate with 5 to 20 assemblies, instead of the hundreds of items in a full
construction project.  Use an Item breakdown (see Lesson ••), and include
as many line items as you need to cover all the work.

Remodeling
For large and whole-building projects, you’ll probably save time by entering
project dimensions (see Lesson ••), and then having Goldenseal calculate
quantities for you. There is no need to enter all the dimensions— just enter
the ones that apply to the project you are doing. For smaller projects, don’t
bother with the dimensions, and just enter quantities for each line item by
typing them in directly.

If you are building with your own crews, you’ll probably use an Item
breakdown (see Lesson ••) and start from a template (see Lesson ••). For
work inside an existing building, use the gut/rehab, kitchen remodel or bath
remodel template. You can also create your own estimating templates for
the specific types of projects you do. If you do the same types of jobs frequently, set up templates for each of

your usual project types (see Lesson ••).
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Interior Work— Framing, Drywall, Painting Etc Rough Estimates
Interior specialty work is easier to estimate, since it requires fewer line
items. You can probably put together something like an interior drywall or
plastering estimate with 5 to 20 assemblies, instead of the hundreds of
items in a full construction project.  Use an Item breakdown (see Lesson
••), and include as many line items as you need to cover all the work.

For architects, developers and design-build companies, Goldenseal works
well as a budgeting tool, to give quick rough estimates during the design
stage. Start with a template (see Lesson ••), fill in project dimensions (see
Lesson ••), then hit the Update Quantities button to get a quick estimate
of pricing for a ‘standard’ style of construction. You can then add specific
line items to refine the calculated cost.For larger projects, enter project dimensions (see Lesson ••) or room

dimensions (see Lesson ••). Goldenseal will use that information to
calculate quantities for you. There is no need to enter all the dimensions—
just enter the ones that apply to the project you are doing. For smaller
projects, don’t bother with the dimensions, and just enter quantities for
each line item by typing them in directly.

For ‘what if’ estimates, you can use Project Phases to create separate sub-
projects that can be easily added to or removed from the main project
estimate (see Lesson ••). Allowances and Bids are also useful tools for
filling in rough estimate prices, that you can replace later with a more
accurate price (see Lesson ••). You can also duplicate an estimate, and
then work on more than one copy of the same basic plans, but with
different details.If you do the same types of jobs frequently, set up templates for each of

your usual project types (see Lesson ••).

Standard Plans and OptionsSmall Jobs and Repairs
If you have standard models or stock projects that you do frequently,
create a template for each of them, so you can easily start out with a new
estimate that has all those details already filled in.

For very small ‘handyman’ projects, you can use a simple Category
breakdown and just type in a brief description of the work you’ll do (see
Lesson ••).  In that case, you won’t use any of the unit prices stored in
Goldenseal, but you’ll still be able to get a professional-looking proposal
form, and you can compare actual job costs against your estimate.

There are several ways to add ‘options’ to your stock plans. Set up smaller
items as Assemblies (see Lesson ••). Set up larger sub-projects as Project
Phases (see Lessons •• and ••). For items that have a variable cost
depending on final specs, use an Allowance (see Lesson ••). When working
on a specific project, you can then easily add or remove the options.

For larger handyman projects, it may help to use an Item breakdown,
similar to the interior and exterior jobs previously described. You may want
to add some additional setup and cleanup time for smaller jobs, and
increase the unit costs if the quantities are very small.

Custom and Unusual Projects
Goldenseal includes a wide variety of construction unit costs, and you can
easily add more Assemblies to match your local style of construction. Even
for unusual projects, you’ll probably find that basic Assemblies will cover
90% of project costs, or more.

For unusual details, you can add ‘unlisted’ line items, and type in a price
for any additional work that is not covered by an Assembly. You can also
add a small ‘sticks and bricks’ estimate to cover custom work— just add
some labor and material line items directly to the estimate.
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Lesson One: Estimating Setup Creating New Unit Costs
Almost all Goldenseal users will want to create some new unit costs. We
provide a good ‘starter’ set of costs for many fields of construction, but it’s
unlikely that we’ll have every single construction method you might want to
use.

Before you create estimates, there are a few things you should set up in
Goldenseal, to get it ready for your own personal style of estimating.

Customers and Prospects To create a new unit cost, follow these steps:

1. Choose Assemblies from the Costs menu.If you are estimating a project for a customer or a possible customer, create
a record for them in Goldenseal, before you prepare an estimate for them. 2. Use the Find command to see if the cost is already included in

Goldenseal (see page ••• for instructions on finding costs).
If you have already done business with the person, follow these steps to
create a Customer account: 3. If the item is not already in Goldenseal, locate the closest possible

record.
1. Choose Customers from the Accounts menu. 4. Choose Duplicate Record from the Edit menu.
2. Click the New button. HINT: You can also create a new, empty record by clicking the New

button. But then you’ll need to think harder about all the details!3. Enter the customer’s name, and any other information you want to
store about them. 5. Change any details that are different for the new unit cost.
HINT: If you are in a hurry now, just enter the customer’s name. You
can come back later and fill in other details for them, if you want.

6. When you are finished, click the Enter key to save the record.

If the new Assembly requires a new type of material, follow these steps:4. Hit the Enter key on your keyboard to save the record.
1. Choose Cost Items from the Costs menu.If you have not yet done business with the person or business, follow these

steps to create a Prospect record for them: 2. Use the Find command to see if the material is already included in
Goldenseal (see page ••• for instructions on finding costs).

1. Choose Prospects from the Income menu. 3. If the material is not already in Goldenseal, locate the closest possible
type of material.2. Click the New button.

3. Enter the prospect’s name, and any other information you want to
store about them.

4. Choose Duplicate Record from the Edit menu.
5. Change any details that are different for the new material.

4. Hit the Enter key on your keyboard to save the record. 6. When you are finished, click the Enter key to save the record.
HINT: Later on, you can use the Convert to Customer button to
create a Customer account from this prospect.

Calibrating Unit C osts
If you are a construction contractor,  start with one of the Goldenseal
starter files (see page ••). They include construction unit costs which make
it easy to create accurate estimates, very quickly.  However, to get the best
accuracy from Goldenseal, you should calibrate our unit prices to match
your own local costs, style of construction, and quality of work.

Lesson •• explains how to calibrate your labor and material prices.

Page 12 Lesson One Estimating Setup Lesson One Estimating Setup Page 13



Lesson Two: Estimate Records Creating a New Estimate
To create a new estimate, follow these steps:

Goldenseal stores each estimate that you create as a record in your
Goldenseal company file. You’ll always be able to access the record,
whenever you open your company file.

1. Choose Estimates from the Income menu.
2. Click the New button.

HINT: You can also click on the template button (the triangle next to
the New button), and start from a template (see page •••).If you actually do work on the project, Goldenseal will use the estimate as a

comparison against your actual job costs, so you can see how accurate the
estimate was. For a draw schedule or progress payment project, Goldenseal
also uses the estimate to determine the billing amounts, as you complete the
project. And if you build the estimate using Assemblies, you can use the
estimate to create contracts, material lists, tool lists and a schedule for the
work.

3. Click on the Breakdown popup field, and enter the type of breakdown
you’d like to use.
HINT: There is more about the different types of breakdowns in the
next few lessons.

4. Fill in details for the work you’ll be doing on this project.

Storing Estimates
Even if  your estimate is not accepted, you can keep it on file in case the
client changes their mind, or in case you have a similar project sometime in
the future. Goldenseal automatically stores all of your estimates for as long as you

want to keep them. You don’t have to do anything special to save them.HINT: You can use the browser control at the upper left corner of the
window to view different Estimate records. You can also use the Find
command to locate specific records (see Lesson 9 in the Basics manual).

HINT: Many people keep all their old estimates on file, for the lifetime
of their business. It can be very helpful if you get a similar project, or if
a client changes their mind later and wants the work done after all! You
may also find the historical data to be helpful in resolving disputes, or
when you are curious about past prices.

Estimates come in three different sizes:

• Simple estimates work well for very small jobs, or if you have already
calculated an estimate price by some other method (see Lesson 3).
They just include a price, and a description of the work. If you do want to remove an estimate, choose Delete Record from the Edit

menu, to permanently delete it from your company file. You can also enter
Void into the Status popup field, if you don’t want to use it, but want to
keep it on file.

• Category breakdowns let you type in a more detailed estimate,
without using unit costs (see Lesson 4). They work well for small or
unusual jobs, or for if you have already calculated an estimate price
by some other method.

Browsing Through Estimates• Item breakdowns are a list of unit costs, plus any unusual items (see
Lesson 5). They are the most detailed way to do estimates, and they
save you time by calculating prices automatically. They also can give
you a schedule, contract, material list and tool list. Item breakdowns
work best for larger projects, and for projects that are similar to work
you have already done.

After you have created multiple estimates, you can ‘browse’ through them
by clicking on the right and left pages of the ‘book’ control at the upper left
corner of the window.

HINT: For more about viewing records, see Lesson Three in the
Goldenseal Basics manual.HINT: Goldenseal estimates come in three sizes, just like the three

bears who used to play in that heavy metal rock band called
Goldilocks. One of them will be “just right” for each project that you
need to estimate!

Goldenseal also includes a Find command that makes it easy to locate an
estimate, even when you have hundreds or thousands of records. For more
about the Find command, see Lesson Six in the Goldenseal Basics manual.
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Lesson Three: Simple Estimates HINT: You can also let Goldenseal save the record automatically. It
does that when you close the Estimates window, or Exit from
Goldenseal, or move to a different Estimate record. It also saves
before printing.For very simple estimates, you can just type in a price and brief

description, and get a quick estimate in a few minutes time. This is the best
way to create an estimate if you have already calculated a price by some
other means, or if you are good at guessing.

More InfoTo create a simple estimate for a prospect, follow these steps:
Click the More Info botton to enter more details about this estimate. It
opens a supplementary window where you can fill in some optional fields.

1. Choose Estimates from the Estimates menu.
2. Click the New button. If it shows you a list of templates, choose New

Empty Estimate from the popup menu.
3. Click on the Breakdown popup field (at left) and choose None.
4. Click on the Account Type popup field, and enter Customer if the

estimate is for an existing customer, or Prospect if not.
5. Enter a specific customer or prospect into the Account Name field.

NOTE: If you haven’t entered a record for the customer or prospect
yet, you’ll need to do that first, before creating an estimate for them.

Enter the following details in the Project Info section:

• Time Period— for a recurring budget, enter a time period. Otherwise
enter Single Use.

• Project Size— enter the size of the project in square feet, square
meters, or whatever unit makes sense for the project.

• Contract— If you have created a contract for this project, Goldenseal
fills in a link to it.

5. Click the More Info button to enter additional info about this estimate.
6. When you are finished entering data, hit the Enter key to save changes.

• Working Hours— Enter the hours worked by crews on this project
(see page ••).

• Supervisor— Enter the employee who is supervising this project.
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Enter the following details into the Job Cost Info section: Lesson Four: Category Breakdowns
• Category System— Fill in the Category System used for this estimate.

It will control the categories and subcategories that appear in the
breakdown table, if the estimate has one (see Lessons 3 and 4).

If you don’t want to use unit costs but do want to itemize an estimate in
more detail than the simple estimate, use a Category breakdown. It lets you
‘build’ an estimate from a detailed list of project components. To use a
category breakdown, follow these steps:

• Location Package— Fill in the set of locations you’ll use for this work.

Enter the following details into Billing Setup:
1. Choose Estimates from the Estimates menu.• Payment Terms— Enter the terms you will use for payments on this

project. 2. Click the New button. If it shows you a list of templates, choose New
Empty Estimate from the popup menu.• Message— If you’d like to print a message onto the printed proposal

form, enter it here. 3. Click on the Breakdown popup field (at left) and choose Category.
You’ll see a new layout that includes a breakdown table (the area near
the bottom of the window, below the Update Shedule button).

• Sales Rep— Enter the employee who gets a commission for this work.

Enter the following details into Other Info:

• Job Type— You can enter a job type as a way to classify this estimate.
• Prepared By— Enter the employee who prepared this estimate.
• Project Address— Goldenseal automatically fills in the address of the

customer or prospect. You can type in a different address, if the work
is not at their regular billing address.

After you have filled in the More Info fields, click OK to save the info.

Using Simple Estimates
After you create a simple estimate, you can print out a proposal form for
the customer, using the Simple Estimate form (see page •••). You can also
use the estimate for job costing and draw schedule billing.

NOTE: Simple estimates do not include any unit cost details, so they
won’t automatically create a schedule, material list or contract. If you
want Goldenseal to provide those features, you’ll need to use an Item
breakdown (see Lesson 5).

4. Click in the first (far left) column in the breakdown table, and enter
the cost area for the first item. You can use labor, materials,
equipment time, or another cost area (see page •••). You can type it
into the cell, or you can click in the cell, then click the ‘triangle’ button
to choose from a list of available choices.

5. Press the Tab key to move to the next column, and enter a category.
6. Press the Tab key, and enter an optional subcategory.
7. Press the Tab key, and type in a brief description for this item.
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8. Press the Tab key, and type in the cost of one item. Press Tab again
and enter the unit size for this item, then tab and enter a quantity.

Category Cost Areas
You can include any of the following basic unit costs in category
breakdowns:9.  After you enter cost and quantity, Goldenseal automatically

computes the total cost (unit cost times quantity).
Equipment— For equipment usage.10. Hit the Enter key on your keyboard to add a new row.
Labor— For employee labor.11. Repeat steps 4 to 10 for each component in the estimate.
Material— For materials.
Subcontractor— For subcontractor costs.
Other Cost— For other costs.

HINT: In category breakdowns, you’ll type text into the Cost Item
cell for these items. In item breakdowns, you’ll choose specific cost
items or assemblies from a clairvoyant field.

PO & WO— A cost from a purchase order or work order.

You can also use any of the special cost areas listed on page ••.

Using Category Breakdown Estimates
After you create a category estimate, you can print out a proposal form for
the customer (see page •••). You can use any of the printed forms,
depending on the amount of detail that you want to show to the customer.

The category breakdown gives you a detailed estimate of costs for each
category of work in the project, so you can get detailed ‘estimate vs actual’
reports, if you also have the accounting portions of the Goldenseal
software. You can also use the estimate as a basis for Draw Schedule or
Progress Payment billing for the project.12. You’ll probably want to add one or more additional lines for your

overhead, profit and other ‘soft’ costs, unless you already included
markup in the other line items, to cover those costs. You can do that
by adding line items that use Percent of Hard Costs or some other
percentage calculation (see Lesson ••).

You can include Allowances, Bids and Project Phases in a Category
estimate. See Lesson ••• for more about those special items.

Estimates with a category breakdown do not include any unit cost details,
so they won’t automatically create a schedule, material list or contract.13. Enter an account, a brief description, and a project start date.

14. Click the More Info button to enter additional billing and job cost
details for this project.

15. Click the Cost Summary button to see totals for labor, materials and
other costs.

16. To print the estimate for a customer, choose Print Forms from the File
menu (see Lesson •• for more about printing).
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Lesson Five: Item Breakdowns 7. Press the Tab key, and enter an optional subcategory.
8. Press the Tab key, and enter a cost item or assembly.

HINT: You’ll only see Cost Items that belong to the entered category
and subcategory (or all items, if there is no category). If the list is
very long, it may take a few seconds to display.

For many projects, you can get very quick and accurate estimates by using
an Item breakdown. Item breakdowns ‘look up’ unit costs to calculate the
cost of each project component, so you don’t need to guess at the price.

9. Press the Tab key, and enter the quantity you will use.HINT: To save even more time, use a template to start out with items
for a ‘standard’ project (see page •••), and use dimensions to calculate
the quantities you’ll need for each item (see Lesson •••).

HINT: On larger projects, you can use estimate dimensions (see page
••) and/or room dimensions (see page ••) to calculate the
quantities you need for each item.

To create a simple estimate with an item breakdown, follow these steps: 10. Press the Tab key, and enter an optional location. Notice that
Goldenseal automatically calculates the line item cost, and the total
cost for all breakdown items.

1. Choose Estimates from the Estimates menu.
2. Click the New button. If it shows you a list of templates, choose New

Empty Estimate from the popup menu. 11. To add another item, press the Enter key, then repeat steps 5 through
10 for each item of work in the project.3. Check the Breakdown popup field on the left side of the window. If it

doesn’t already say Items, click on the field and choose Items. 12. You’ll probably want to add one or more additional lines for your
overhead, profit and other ‘soft’ costs, unless you already included
markup in the other line items, to cover those costs.

13. After you enter all the details of the project work, you’ll end up with a
detailed description of the project, and an accurate calculation of the
total cost of the work.

4. Enter an account, a brief description and a start date.
5. Click in the first column of the breakdown table, and enter a cost area.

You can use an assembly, labor, materials, equipment time, or another
cost area (see pages 22-23).

6. Press the Tab key to move to the next column, and enter a category.
HINT: If you don’t know the names of the cost categories, click the
popup button to see a list of categories. If you don’t know which
category to use, just leave the field blank.
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Using Item Breakdown Estimates Estimate Templates
After you create an itemized estimate, you can print out a proposal form
for the customer (see page •••). You can use any of the printed forms,
depending on the amount of detail that you want to show to the customer.

Most of the Goldenseal starter files include estimating templates, which
include a list of all the Assemblies that go into typical projects. When you
create an estimate from a template, it starts out with most of the work
already done for you!The item breakdown gives you a detailed estimate of costs for each

category of work in the project, so you can get detailed ‘estimate vs actual’
reports, if you also have the accounting portions of the Goldenseal
software. You can also use the estimate as a basis for Draw Schedule or
Progress Payment billing for the project.

HINT: Most of the Goldenseal starter files already include a few
templates for common types of projects.

To create an estimate from a template, follow these steps:

1. Choose Estimates from the Estimates menu.
You can include Allowances, Bids and Project Phases in an Item estimate.
See Lesson ••• for more about those special items.

2. Click the template button (the triangle just to the right of the New
button).

The itemized estimate automatically calculates a project schedule for the
work, based on the start date and crew sizes you enter for the work (see
Lesson ••).

3. Choose a template from the popup menu that appears.
4. Goldenseal will make a copy of the template.
5. Fill in project dimensions and other details on the estimate, as

described in the previous few pages.You can also use the estimate to create a detailed material takeoff (see
Lesson •••) and a detailed Scope of Work for spec sheets or contracts (see
Lesson •••).

After you have created a detailed estimate for a particular type of project,
you can easily turn it into a template, and use it for future projects. To do
so, follow these steps:

1. Choose Estimates from the Estimates menu.
2. Locate the estimate you want to turn into a template.
3. Choose Template this Item from the Options menu.
4. Fill in a name for the new template, then click OK.
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Basic Cost Areas Percent of Labor— A simple percentage of all labor costs (direct labor
costs, and the labor portion of assemblies).You can include any of the following unit costs in item breakdowns:

Percent of Material— A simple percentage of all material costs (direct
material costs, and the material portion of assemblies).Assemblies— An assembly is a unit cost that is a combination of labor,

materials and other expenses. It is not available in category
breakdowns. For more about assemblies, see Lesson 14. Percent of Total— A simple percentage of the complete project cost.

HINT: You can use the percentage options for ‘markup’, or for
specific expenses that are a percentage of your actual costs.Assembly Labor/Materials— Just the labor or materials portion of an

assembly. Use it when you only provide part of an assembly.
Percent of Subs— A simple percentage of all subcontractor costs (direct

subcontractor costs, and the subcontractor portion of assemblies).
Assembly Schedule Only— Includes assembly time in the estimate, but

does not include the cost. Use it when you are not responsible for
some work, but need to wait for it to be completed by others. Profit— An amount that you type in for profit.

HINT: If you calculate profit as a percentage, use Percent of Hard or
Percent of Total instead.

Equipment— For equipment usage.
Labor— For employee labor.

Reminder— A reminder you’d like to get during this project.Material— For materials.
Sales Tax— An amount to cover sales tax that you pay to vendors.Subcontractor— For subcontractor costs.
Soft Cost— Any other cost that you want to add to the estimate.Other Cost— For other costs.
Tool— A tool that you’ll use during this project.HINT: In category breakdowns, you’ll type text into the Cost Item

cell for these items. In item breakdowns, you’ll choose specific cost
items or assemblies from a clairvoyant field.

Unlisted Items— In Item breakdowns, you can use one of the five
Unlisted choices. They give you a type-in field so you can enter your
own text, rather than choosing from a clairvoyant field.

Special Cost Areas
Some cost items refer to other transactions, and fill in a calculated value:

Allowance— You can enter any allowance that has not yet been awarded.
There is more about allowances in the next section.Goldenseal includes several other cost areas for miscellaneous costs in an

estimate. For some cost areas, you type in a description and an amount. Bid— You can enter any bid that you have received for this job. There is
more about bids later in this lesson.Commission— An amount to cover commissions paid to sales reps,

brokers, or others who collect a commission. PO & WO— A cost from a purchase order or work order.
Contingency— An amount to cover unexpected problems, forgotten

items, and similar contingencies.
Project Phase— A cost from a project phase (see Lesson ••).

Delay— A delay entered for scheduling (see Lesson 5).
Delivery Charge— An amount for shipping or delivery charges.
Overhead— An amount that you type in to cover overhead expenses.

HINT: If you calculate overhead as a percentage, use Percent of Hard
or Percent of Total instead.

Percent of Equipment— A simple percentage of all equipment costs (direct
equipment costs, and the labor portion of assemblies).

Percent of Hard— A simple percentage of all hard costs (assemblies,
equipment, labor, materials, subcontractors and other costs).
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Lesson Six: Printing Estimates If you want to show a lot of detail in your estimate, use the Cat/Subcat
Estimate, Category Estimate or Itemized Estimate forms. Those show every
single line item. That will often convince a client that you have thought
carefully about the project and will do a good job.

When you have finished an estimate and want to print a proposal for the
customer or prospect, follow these steps:

If you want to show less detail in your estimate, use the Category Only
Estimate or the Subcategory Estimate forms. Those show some detail about
project costs, without showing every single line item of work.

1. If you aren’t already looking at the estimate, choose Estimates from
the Income menu, and locate the estimate you want to print.

2. Choose Print Forms from the File menu.
If you want an extremely simple estimate, use the Simple Estimate form.
That shows no details at all.  Just a price.

3. Choose a form to print (see below).
4. Click the Print button.
5. You’ll see a print dialog for your printer. Select printing details, and

print the form.
HINT: On many computers, you can print to a fax, or print a .pdf
file that you can attach to an email and send to your clients. If your
computer doesn’t already provide those features, there are
inexpensive utilities that will do it for you.

Form Types
Goldenseal includes six different printed forms for estimates. Each shows a
different amount of detail.

• Cat/Subcat Estimate— Lists every breakdown line item, broken down
by categories and subcategories.

• Category Estimate— Lists every breakdown line item, broken down
by categories.

• Category Only Estimate— Lists totals for each category of work.
• Itemized Estimate— Lists every breakdown line item in a simple list

(no categories or subcategories used).
• Simple Estimate— Shows a total price with no other details.
• Subcategory Estimate— Lists totals for each category and

subcategory of work.

Levels of Detail
All of the estimate printed forms look like a typical business form, with
your company logo, and general information about the customer and your
business.

The different forms have different amounts of detail about the project, so
you can ‘fine tune’ what you show to the customer.
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Lesson Six: Estimate Dimensions  Basic Dimensions

To enter basic dimensions for an estimate, follow these steps:Estimate dimensions calculate quantities for each line item in an estimate
with an item breakdown (see Lesson ••). They make estimating quicker
and more accurate for many types of construction projects.

1. Click on the first dimensions button, or choose Estimate Dimensions
from the Options menu, and choose Basic Dimensions from the
submenu.

When to Use Dimensions
Goldenseal’s construction dimensions work best for the following types of
work:

• New construction— building an entire new building
• Additions— attaching some new construction to an existing building
• Gut/Rehab work— doing extensive work to one or more rooms in the

interior of an existing building, with or without work on the exterior

You can also use dimensions for the following types of projects:

• Roofing an entire roof with new materials
• Painting the entire interior and/or exterior of a building
• Siding installation on the entire exterior of a building
• Flooring replacement on a large portion of an existing building
• Insulation work on an entire building

NOTE: For these types of projects, you don’t need to enter all the
dimensions. Just fill in the basics, and whichever other areas apply to
the type of work you are doing.

You do not need to enter dimensions on the following types of projects:

• Very small jobs
• Remodeling work that is scattered all over an existing building
• Landscaping and other non-building construction

Dimension Buttons
2. You’ll see a dimension window which shows basic measurements for a

construction project.
3. Click in the Widest Width field, and enter the width of the building.Estimates with an Item breakdown have a row of buttons across the

middle. Click on these buttons to open the different dimension screens.
Usually you will work from left to right.

4. Hit the Tab key to move to the Longest Length field. Type in the
building length.
NOTE: For additions, enter the dimensions of the addition. For
gut/rehab work, enter the dimensions of the part of the building on
which you are working.
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5. Hit the Tab key to move to the next field. Keep selecting fields until
you have filled in all dimension fields that apply to this project. Note
that many of the fields calculate automatically, and don’t need to be
filled in (those fields have a locked padlock next to them).

Using Dimensions
Estimate dimensions are used as a ‘suggestion’ for the quantity of cost
items and assemblies that are included in an estimate.

If you started with a estimate template, click the Update Quantities button
when you have finished entering dimensions. Goldenseal will automatically
fill in quantities for each item in the ‘standard’ project.

HINT: If a dimension doesn’t apply to this project, leave it blank.
6. When you’ve finished entering dimensions, click OK.
7. To enter the next set of dimensions, click on the next dimensions

button in the estimate, or choose Estimate Dimensions from the
Options menu, and choose the next dimension in the list (for more
about the other dimension screens, see pages •• to ••).

When you add new items to an Item breakdown, Goldenseal starts with the
suggested quantity. If you don’t like the suggested quantity, you can type in
a different amount.

8. Repeat, until you have entered all dimensions. If dimensions change after you’ve entered breakdown items, click the
Update Dimensions button to recalculate quantities for each item.HINT: For details on the other construction dimensions, see pages

••• to •••.

Dimension Calculations
Calculated Dimensions To see the way dimensions are calculated, choose Calculations from the

Options menu, and choose Calculated Dimensions from the submenu. There
is more about Calculated Dimensions in Lesson ••.

Goldenseal calculates some dimension quantities from other dimensions.
Calculated dimensions have a padlock to the right of the number field.

 When the padlock is locked, the calculated field is automatically
updated whenever there is a change in any field whose value it uses.

To see the dimension that is used for each item in an estimate, choose Cost
Items or Assemblies from the Costs menu, and look at the Suggested
Dimension field (see page ••). When the padlock is unlocked, you can type in a value for the field.

The value in an unlocked field will always stay the same, unless you
re-lock the padlock to return to the calculated value. To change the appearance of a dimensions layout, choose Custom Layouts

from the Options menu, and choose Estimate Dimensions from the
submenu (see page ••).To switch the padlock, click on it. It will switch between locked and

unlocked status.

NOTE: A few calculated fields are always locked, and can never be
changed. Those fields have a gray padlock which cannot be unlocked.

Popup Fields
The Project Type and Number of Stories dimensions use a popup field. To
enter a value, click on the field and choose an item from the popup menu.

Checkboxes
A few dimensions use a checkbox. To enter a value, click on the checkbox
field to turn it on or off.
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 Foundation Dimensions  Roof Dimensions

Many of the starter files include a Roof Dimensions screen, where you can
enter details for the roof on an addition or new building.

Many of the starter files include a Foundation Dimensions screen, where
you can enter details for the foundation of an addition or new building.

To enter roof dimensions, follow these steps:To enter foundation dimensions, follow these steps:
1. Click the Roof Dimensions button in the estimate layout, or choose

Estimate Dimensions from the Options menu, and choose Roof
Dimensions from the submenu.

1. Click the Foundation Dimensions button in the estimate layout, or
choose Estimate Dimensions from the Options menu, and choose
Foundations from the submenu.

2. Enter measurements for any footings or grade beams.
3. Enter measurements for any basement or stem walls (including the

wall around a crawl space). 2. Enter the type of roof, and its slope and overhang.
3. Enter details about any gable ends or dormers.4. Enter measurements for any round piers or pilings.
4. Goldenseal calculates the length of hips, ridges, valleys, rakes and

eaves. If any are incorrect, click on the padlock and type in the correct
quantity.

5. Enter measurements for any floor slabs.
6. Click OK when you are finished.

5. Click OK when you are finished.
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 Structural Dimensions  Exterior Dimensions

Many of the starter files include an Exterior Dimensions screen, where you
can enter details for outbuildings, landscaping, and a few basic building
measurements.

Many of the starter files include a Structural Dimensions screen, where you
can enter details for any new structural framing you’ll be doing.

To enter structural dimensions, follow these steps:
To enter exterior dimensions, follow these steps:1. Click the Structural Dimensions button in the estimate layout, or

choose Estimate Dimensions from the Options menu, and choose
Structural from the submenu.

1. Click the Exterior Dimensions button in the estimate layout, or choose
Estimate Dimensions from the Options menu, and choose Exteriors
from the submenu.

2. Enter measurements for any garages, decks, porches and outbuildings
that are part of the project.

3. Enter areas for landscaping and driveways.
2. Enter measurements for framing thickness, sheathing thickness,

stud/joist/rafter spacing, and demolition quantities, for each of the
basic framing areas.

4. Enter vertical measurements for the building.
5. When you are finished, click OK.

3. Enter the quantity of each type of room that is included in the project.
4. When you are finished, click OK.
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 Window & Door Dimensions Finish Dimensions

Many of the starter files include a Window & Door Dimensions screen,
where you can enter details for windows, doors, and a few minor trim
items.

Many of the starter files include a Finish Dimensions screen, where
Goldenseal calculates final areas for drywall, paint, insulation, and other
finish details.

To enter window and door dimensions, follow these steps: To enter finish dimensions, follow these steps:

1. Click the Window Dimensions button in the estimate layout, or choose
Estimate Dimensions from the Options menu, and choose Windows &
Doors from the submenu.

1. Click the Finis Dimensions button in the estimate layout , or choose
Estimate Dimensions from the Options menu, and choose Finish
Dimensions from the submenu.

2. Enter the quantity and size for any windows, doors and skylights that
are included in the project.

3. Enter the number of additional room corners.
2. Check the calculated areas. If any are incorrect, click the padlock and

type in a different number.4. Goldenseal calculates the baseboard length. If it is incorrect, click the
padlock and change it.

3. Enter the number of paint coats used on each surface.
5. Enter trim widths, attic floor area, and other minor trim dimensions.

4. Enter the thickness of insulation used on each surface.
6. When you are finished, click OK.

5. When you are finished, click OK.
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Lesson Seven: Room Dimensions
Goldenseal also lets you enter measurements for different locations in an
estimate. For the construction dimensions in the Sample Company File,
locations are used for individual rooms in a remodeling project.

When to Use Room Dimensions
Use room dimensions by themselves for the following types of work:

• Remodeling— work scattered all over an existing building
• Repairs— repainting and other minor work in an existing building
• Mixture of Ceiling Heights— if there is a wide variety of ceiling heights,

the room-by-room approach may be more accurate than basic
dimensions

• Unusual projects— for odd building shapes that can’t be handled
easily by the basic dimensions

• No floor plan— for interior remodeling projects with no blueprints, so
inside room measurements are all you have for the project

Use room dimensions in combination with basic dimensions for the
following types of work:

• Work in the existing building, when the main project is an addition
• Small additions, when the main project is a gut/rehab
• Any other mixture of two distinct types of work (use the basic

dimensions for one type, and rooms for the other)

Changing Room InfoNOTE: When you use rooms and basic dimensions, Goldenseal will
add all dimension quantitities together.

To change the measurements for a room, choose Estimate Locations from
the Options menu, and choose a specific room from the submenu. You can
then change any quantities on the room entry screen.Entering Room Dimensions

To enter room dimensions, follow these steps: To rename a room, choose Estimate Locations from the Options menu, and
choose Rename Location from the submenu.1. Choose Estimate Locations from the Estimates menu, and choose Add

Location from the submenu. To delete a room, choose Estimate Locations from the Options menu, and
choose Delete Location from the submenu.2. Type in an name for the location, then click OK.

3. You’ll see a location dimension window.
4. Enter measurements, the same as for regular dimensions.
5. Repeat steps 1 to 4 for each additional room. Each estimate can have

any number of separate rooms/locations.
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Room Calculations Single Room Dimensions
As you enter measurements for each room, Goldenseal will calculate the
total lengths and areas for framing, wallboard, painting, insulation, and
other construction work. If you have also filled out basic project dimensions
(see Lesson Six), Goldenseal will add together those measurements, and the
totals from the rooms.

Goldenseal includes an optional Room column in the item breakdown table
for Estimates. You can use it to enter a specific room location for each line
item when making ‘room by room’ estimates. When you enter a room
location, Goldenseal will fill in a suggested quantity for that line item, by
using the listed dimension for the specific room that you entered.

Each Assembly has a ‘suggested’ quantity, which is calculated from the
appropriate construction measurements. You’ll see the suggested quantity
whenever you add a new item, or when you click the Update Quantities
button on the Estimate window.

Entering Rooms
To enter a line item for work in a specific room, follow these steps:

1. Add a line item to the breakdown table (see page ••).

Setting Up Suggested Dimensions
2. Click in the Room column, and select a room.
3. Goldenseal will automatically fill in the suggested quantity for that

room.Each Cost Item and Assembly uses a dimension or calculated dimension to
fill in a suggested quantity when you first fill in the line item, or when you
click the Update Quantities button.

To enter a suggested quantity for an Assembly, follow these steps:

1. Choose Assemblies from the Costs menu.
2. Locate the Assembly you’d like to change.
3. Click the Sales Setup button.
4. Turn on the Calculated Dimension checkbox to use a calculated

dimension, or turn it off to use a regular dimension value.
5. Enter the desired dimension into the Suggested Dimension clairvoyant

field.
6. If you want to use dimensions from a specific room location, also fill

in the Suggested Room Dimension fields.
7. Click OK.
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Lesson Eight: Bids 5. Turn on the Rough Estimate checkbox if you don’t have a firm price
quote, yet, and want to start with a ballpark estimate for the work
(see below).

Use Bids to handle supplier or subcontractor price quotes that you receive
before you submit an estimate. You can also use a Bid as a ‘placeholder’ for
work that you will subcontract, even if you don’t get a price from the sub
before submitting your own bid to the client.

6. If this is a competitive bid, enter the bid that it competes with. You
can have any number of bids competing with each other (see page 44).

7. Click the More Info button, and enter any other details that apply to
this bid.

NOTE: In Goldenseal, we use the term Estimates for quotes you give a
client, and Bids for quotes you get from a supplier or subcontractor. On
your printed forms, you can call them whatever you want!

8. Hit the Enter key to save the Bid record.

Bid Details
Creating Bids Click the More Info button in the Bid window to enter additional details

about the bid.
To enter a Bid, follow these steps:

   1. Choose Bids from the Income menu.
2. Click the New button.
3. Enter the business giving the bid, and a brief description of the bid.

You can also enter a more detailed description into the Details field.
4. Enter the bid price of the item. If the bid price is for just one unit and

more than one will be included, turn on the Cost per Unit checkbox.
HINT: If the checkbox is on, Goldenseal multiplies the cost by the
number of units in the estimate. Otherwise it uses a flat cost.

You can enter the following fields in the More Info window:

Category— enter the cost category where you’d like to include this bid.
Subcategory— enter the optional subcategory for this bid.
Location— you can enter a cost location where this work will be done.
Hours & Crew Size— enter the number of person-hours it will take to

complete the work in this bid, and the number of workers.
Warn if Overbilled— turn on the checkbox to have Goldenseal prevent

you from overpaying this item.
Contract Text— enter the text to use in contracts, to describe this work.
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Using in Estimates Competitive Bids
To include a bid in an estimate, follow these steps: When you have suppliers or subcontractors that compete for the same

work, enter a separate bid for each vendor that will submit a bid to you. In
the first bid, leave the Competes With field blank. In all other bids, enter
the first bid into the Competes With field.

1. Create an estimate, or open an existing one. Give the estimate a
category or item breakdown, if it doesn’t already have one.

2. Add a new row to the breakdown table (see page •••).
HINT: Turn on the Rough Estimate checkbox in the first bid if you want
to start with an approximate price in the estimate. Goldenseal will use
it at first, but then replace it as soon as you have a real bid.

4. Enter Bid into the Cost Area column.
5. Enter the bid you want to use into the Cost Item column.

HINT: Click on the popup button in the Cost Item column to see a
list of available bids. If there is a category in the breakdown line,
Goldenseal only shows bids under that category.

When you first enter competing bids, Goldenseal ignores any bids that have
a zero amount. That way you can enter planned bids, and use the Status
field to track progress through the bidding process.6. Hit the Enter key to save the Estimate record.
As you receive actual quotes from suppliers and subcontractors, enter the
bid amount into the Gross Price field. Goldenseal will automatically keep
track of the low bid. The estimate will show the low bid amount.

Goldenseal automatically updates the estimate if a bid price changes. It
always uses the price of the lowest competing bid.

Rough Estimates
Bid BreakdownsUse a ‘rough estimate’ bid to fill in a value for the work, even before you

receive price quotes from your subcontractors or suppliers. Just turn on the
Rough Estimate checkbox to mark a Bid as a rough estimate.

If you want to calculate a Bid in detail, you can use a Category breakdown
or an Items breakdown, very similar to the way you’d create a detailed
estimate. Click on the Breakdown popup field on the left side of the
window to change the breakdown type for a Bid. See Lessons 4 and 5 for
more about these two types of breakdowns.

To calculate the cost of the work, you can do any of three things:

1. Make a guess or do some calculations by hand, and type it into the
Gross Price field.

Bid Tracking
2. Change the breakdown popup field to Category, and fill in a detailed

list of costs, similar to a category Estimate (see page ••).
Use the Status field to track progress on bids that have not yet been
received from your vendors or subcontractors. You can mark a bid as
Entered, Requested or Received.

3. Change the breakdown popup field to Items, and fill in the Cost Items
or Assemblies that cover the work, similar to an itemized Estimate
(see page ••).

If you plan to get bids from subcontractors or suppliers later, fill them in as
competitive bids (see page 44), and have them compete with the rough
estimate price. Leave the price at zero when you haven’t yet received a
price from the vendor, and then fill in a bid price, when you receive it.
Goldenseal will use the rough estimate price to start with, but it will start
using the lowest bid price instead, once they have been entered.

When you change the amount of a Bid, Goldenseal automatically updates
its amount in the estimate. When you change the amount of a competitive
bid, Goldenseal automatically figures the lowest bid, and uses it in the
estimate. It also changes the status of all competing bids to either Low Bid
or High Bid.

To see a consolidated report of all bids in an Estimate, follow these steps:
HINT: You can include ‘rough estimate’ bids in an estimate, even if you
won’t get prices from your vendors before you submit your estimate. 1. Choose Estimates from the Reports menu, and choose Bids from the

submenu.
2. Enter an estimate into the Estimate clairvoyant field.
3. Click the Update button.
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Bid Invoices Lesson Nine: Allowances
When you are ready to start work on a project, you can track invoices and
payments for each bid (as long as your Goldenseal version includes
accounting and job costing features). Goldenseal links all Bids to a Project
account when you award an estimate to that project (see page •••)

Use an Allowance when you need to give an estimate and you don’t have
firm specifications. For example, allowances work well for a kitchen
remodeling that includes appliances, but doesn’t specify brand or model.

To enter invoices for a subcontractor bid, follow these steps: The estimate uses the allowance amount, and allowance billing covers the
difference between the allowance amount and actual costs.1. Choose Subcontractor Costs from the Costs menu.

2. Click the New button. HINT: You might consider an allowance as a small bit of ‘time and
materials’ pricing within a fixed-price estimate.3. Enter the subcontractor account name.

4. Enter the amount, and other details of the invoice.

Creating an Allowance5. Enter the project into the Job field.
6. Enter Bid into the Applies To popup field.

To create an allowance, follow these steps:7. Enter a specific Bid into the Details clairvoyant field.
1. Choose Allowances from the Income menu.You can follow a similar process to link Material Purchases to a material

supplier’s bid. 2. Click the New button.

Bids in Templates
If you frequently use the same types of Bids in your projects, you can
include those Bids in a template, and start out with some ‘starter’ bids,
each time you create a new Estimate.

To control whether Bids and Allowances are duplicated in templates,
follow these steps:

1. Choose Preferences from the Options menu, and choose Income from
the submenu.

2. Turn the Duplicate Allowances & Bids checkbox on or off.
3. Click OK.

Finishing Up 3. Enter a brief description for the allowance item, and a more complete
description in the Details field.Needless to say, you can use Bids for your chic hat projects.
HINT: You can also use a category or item breakdown in an
allowance (see pages 18-21).HINT: Ductwork subcontractors are always happy to give bids on chic

galvanized hats. Just as stylish as Chanel, and much cheaper!
4. Enter the price of the item. If the cost is a single-unit cost that is used

for multiple items, turn on the Cost per Unit checkbox.
HINT: If the checkbox is on, Goldenseal multiplies the cost by the
number of units entered into the estimate. If the checkbox is off,
Goldenseal uses the cost of the allowance with no multiplication.
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5. Enter the way you plan to bill for this allowance, and the payment
terms you’ll use. You can bill for all costs or just for materials. You
can also use a minimum or maximum price for the allowance.

Using in Estimates
To include  an allowance in an estimate, follow these steps:

Allowance Details 1. Create an estimate, or open an existing one.
2. Give the estimate a category or item breakdown, if it doesn’t already

have one.Click the More Info button to enter more details about an allowance.

3. Add a breakdown line (see page •••).
4. Enter Allowance into the Cost Area column.
5. Enter a specific allowance into the Cost Item column.

NOTE: Goldenseal only shows allowances that are not already
included in a different estimate.

When you include an allowance in an Estimate, Goldenseal automatically
adjusts the estimate price, if the allowance changes. If you award the
estimate to a Project account, you can then use Goldenseal’s allowance
billing feature to bill for the difference between the allowance and actual
costs (see page •••).

Allowance Breakdowns
If you want to calculate an Allowance in detail, you can use a Category
breakdown or an Items breakdown, very similar to the way you’d create a
detailed estimate. Click on the Breakdown popup field on the left side of
the window to change the breakdown type for an Allowance. See Lessons 4
and 5 for more about these two types of breakdowns.

You can enter the following fields in the More Info window:

Category— enter the cost category where you’d like to include this bid.
Subcategory— enter the optional subcategory for this bid.
Location— you can enter a cost location where this work will be done.
Hours & Crew Size— enter the number of person-hours it will take to

complete the work in this bid, and the number of workers.
Warn if Overbilled— turn on the checkbox to have Goldenseal prevent

you from overpaying this item.
Contract Text— enter the text to use in contracts, to describe this work.

Goldenseal also shows you the expenses to date, that apply to this
allowance.
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Allowances in Invoices
Allowance TemplatesWhen you are ready to start work on a project, you can track invoices and

payments for each allowance (as long as your Goldenseal version includes
accounting and job costing features). Goldenseal links all Allowances to a
Project account when you award an estimate to that project (see page •••)

You can only use each allowance in one estimate.

If you use the same allowance on many different projects, set it up as a
template (see Lesson 24). That way you can quickly make a copy of the
allowance whenever you need to use it again.To enter material costs for a part of the project that has been allowanced,

follow these steps:
1. Choose Material Purchases from the Costs menu.
2. Click the New button.
3. Enter the material supplier’s account name.
4. Enter the amount, and other details of the invoice.
5. Enter the project into the Job field.
6. Enter Allowance into the Applies To popup field.
7. Enter a specific allowance into the Details clairvoyant field.

You can also apply Equipment Hours, Labor Hours, Other Costs or
Subcontractor Costs to an allowance.

Allowance Billing
Versions of Goldenseal that include accounting functions allow you to bill
for the difference between the original allowance amount, and actual costs.
To ‘settle up’ on an Allowance, follow these steps:

1. Choose Billing from the Bank menu, and choose Allowances from the
submenu.

2. Double-click on a project.
3. Turn on the checkmark next to each allowance that is ready to bill.

NOTE: Goldenseal includes the original allowance amount in with
the main project billing. Markup also applies to the original
allowance amount.
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Lesson Ten: Project Phases
 Creating a Project Phase

A Project Phase is like a ‘mini-estimate’ that you can include as a
component within an estimate. It lets you split a large project estimate into
smaller pieces, so it is easier to manage.

To create a Project Phase, follow these steps:

1. Choose Project Phases from the Income menu.
2. Click the New button.

When to Use Project Phases
Use a Project Phase whenever you want to ‘split off’ part of an estimate
into a separate area. There are many situations when that can help you.

Multiple Buildings, Units, Phases
If your project consists of several buildings, living units or large phases, and
you want to see both separated and combined estimates, set up a Project
Phase for each building, unit or construction phase. You can then have a
master Estimate which includes each of the phases as a line item.

HINT: If you just want to break an estimate down into construction
steps such as foundations, framing, trim and painting, you don’t need
to use Project Phases. Instead, just include the items in a regular
estimate, and use the Category Breakdown report to view estimated
costs grouped by cost categories. You only need Project Phases if you
want an additional way to split the costs.

3. Enter details for the phase. A Project Phase works just like a regular
Estimate, except that it will be included in an Estimate instead of
being used directly.

Options
HINT: You can use a category or item breakdown in a Project Phase
(see pages 18-21).

If the project contains large components that may or may not be included in
the final job, put them into a Project Phase, and include the phase as a line
item in the main Estimate. That way you can easily include or remove it.
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Using in Estimates Lesson Eleven: Markup & Soft Costs
To include a Project Phase in an estimate, follow these steps:

Every business has two basic types of expenses. Direct costs include
materials and labor used directly in construction or other production.
Indirect costs, or overhead, includes all general business expenses that
can’t be applied to specific projects or production.

1. Create an estimate, or open an existing one.
2. Give the estimate a category or item breakdown, if it doesn’t already

have one.
3. Add a breakdown line (see page •••).

NOTE: Direct costs are often called ‘hard’ costs, and indirect costs are
often called ‘soft’ costs.

4. Enter Project Phase  into the Cost Area column.
5. Enter a specific Project Phase into the Cost Item column.

Any business that wants to be successful needs to cover both direct and
indirect costs, and have something left over for profit.

NOTE: Goldenseal only shows phases that are not already included
in a different estimate.

Indirect Costs in Estimates
When you include an allowance in an Estimate, Goldenseal automatically
adjusts the estimate price, if details change in the Project Phase.lowance
and actual costs (see page •••). The most popular way to conver indirect costs in an Estimate is to add one

or more line items that add a percentage of the hard cost amount, sufficient
to cover overhead costs for the busines. To do that, follow these steps:

1. Choose Estimates from the Options menu.
2. Locate the estimate you’d like to change.
3. Scroll down to the last row in the breakdown table, and click

anywhere in that row.
4. Hit the Enter key on your keyboard to add a new row.
5. Click in the Cost Area column, and choose Percent of Hard.
6. Click in the Item column, and type in a brief description.
7. Click in the Amount column, and type in a percentage amount.

Goldenseal will calculate the percentage addition, and adjust it whenever
the total hard costs change.

Using Multiple Markup Line Items
Many people include more than one line item in the estimate, to cover
indirect costs. For example, you may want to include line items for any of
the following indirect costs:

• Overhead— for general business expenses that don’t apply to any
specific project

• Profit— An amount to cover return on investment, business risk, and a
‘reward’ for the previous hard work of te owner((s).

• Conteingencies— an allowance for mistakes, forgotten items, and
unantifcip0ated problems that may occur.
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• Supervision— covering general supervision time that cannot be
allocated to specific projects.

If you use Goldenseal to track expenses, you can get a total of all hard
costs in the period by doing the following:

• Inflation— an allowance for price increases that may occur between
the time of the estimate, and the completion of the project.

1. Choose Expenses from the Reports menu, and choose All Expenses
from the submenu.

2. Enter the desired time period into the Date Range popup field.

Calculating Overhead Percentage 3. Turn on the More Details checkbox to view more report controls.
4. Enter Job Class into the Match Field popup field.Before you can add markup to estimates, you should figure out your total

overhead costs, figured as a percentage of the hard costs in your project
work.

5. Enter Projects into the clairvoyant field next to the Match Field
popup.

6. Click the Update button to see a total of all project expenses during
the time period.To do that, follow these steps:

1. Pick a time period for the calculation.

Calculating Soft Costs2. Calculate your total hard costs in the period.
3. Calculate your total overhead costs in the period. To get a total for soft costs in the period, add together all of the following

expenses:4. Divide overhead by hard costs to get an overhead percentage.

Overhead Time Periods
1. All materials that can’t be allocated to specific projects.
2. Employee labor costs for work done in the office, including employer

taxes and other ‘burden’.You can use whatever time period is most convenient. If you only work on
one or two projects at a time, you might want to start at the beginning of a
large project, and end at the end of that project. If you work on many small
projects, it may be more convenient to use a quarter, half year or full year
for the period.

3. Equipment costs that can’t be allocated to a specific project.
4. Subcontractor costs that can’t be allocated to a specific project.
5. Other general business costs such as insurance, advertising, office

expenses, and any other costs that can’t be allocated to a project.

Calculating Hard Costs
6. Value of owner time spent on general business work, based on

estimated or actual times.
To get a total for hard costs in the period, add together all of the following
expenses:

If you use Goldenseal to track expenses, you can get a total of all soft costs
in the period by doing the following:

1. Materials used on all project work during the period. 1. Choose Expenses from the Reports menu, and choose All Expenses
from the submenu.2. Employee labor costs for work done on project, including employer

taxes and other ‘burden’. 2. Enter the desired time period into the Date Range popup field.
3. Equipment costs, based on actual costs, or an estimated cost rate. 3. Turn on the More Details checkbox to view more report controls.
4. Subcontractor costs. 4. Enter Job Class into the Match Field popup field.
5. Other project costs such as building permits, project utilities,

insurance for specific projects, and other expenses that can be
assigned to a specific project during the time period.

5. Enter Overhead into the clairvoyant field next to the Match Field
popup.

6. Click the Update button to see a total of all non-project expenses
during the time period.6. Value of owner time spent on projects, based on estimated or actual

times.
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Calculating Overhead Percentage Paying to Suppliers
Once you have calculate totals for project and overhead expenses, you can
calculate an overhead percentage to use in estimates by dividing the
overhead total by the project total.

If you pay sales tax to your suppliers and don’t collect it directly from the
customer, then you’ll need to add a soft cost line item to cover the sales tax
you pay. To do that, follow these steps:

For example, if your overhead expenses were $12,000 in the period and
your project expenses were $72,000, use an overhead percentage of
12000/72000, or about 16.7%.

1. Add a line item to the estimate (see page ••).
2. Enter Percent of Materials into the Cost Area column.
3. Enter Sales Tax into the Category column.

Calculating Profit Percentage
4. Enter a short description into the Item column.
5. Enter the sales tax rate you pay into the Amount column.
6. Goldenseal will automatically add a percentage of material costs, to

cover the sales tax you pay on them.If you use an overhead line item to cover your general business expenses,
then your profit percentage only needs to cover your net profit— an amount
that helps reward the owner for their investments in money and time, and
the risks that they take.

NOTE : If you also pay tax on subcontracted work, repeat the steps
above, but use Percent of Subs.

Contingencies
Some industries have ‘rule of thumb’ figures for reasonable net profit, but
usually it’s an amount you need to decide on.  It really can’t be calculated
from any other numbers. It is a very good idea to add a contingency percentage to all estimates. It

will help you to cover forgotten items, unexpected problems, weather
delays, and any other costs that are not covered in the hard costs, or other
soft costs.

You may need to adjust the profit percentage for competitive reasons— if
you are losing too many bids, you may want to adjust it down. If you are
too busy, you might as well adjust it up and become more profitable!

Every type of work has a different risk factor, but you might want to use
anywhere from 3% to 10% contingencies in your construction project
estimates, depending on the risks involved.Sales Tax

Goldenseal provides two different ways to handle sales tax, VAT, GST,
PST or other taxes on project work.

Other Soft Costs
Collections from Customer Goldenseal allows you to add as many additional soft cost line items as

you’d like. You might want to include a line item to cover any of the
following expenses:If you collect sales tax from the customer and then pay it to the

government, follow these steps:
• Closing costs1. Choose Income Setup from the Income menu, and choose Job Sales Tax

from the submenu. • General supervision
• Inflation allowance (sometimes called ‘escalation’)2. Click the New button.

3. Enter details for the tax that you collect.
4. Click OK.
5. Repeat steps 2 to 4 for each tax you collect, then close the list.
6. Enter a sales tax rate into the Sales Tax clairvoyant field in the

estimate.
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Lesson Twelve: Awarding
Estimates Tracking Estimate Expenses

If you have the complete version of Goldenseal, you can use the Job Costs
command to track actual expenses against the original estimate. See
Lessons 34, 35 and 39 for more about job cost tracking.Submitting and Awarding Estimates

Billing for Estimates
To mark the progress of an estimate, click on the Status popup on the left
side of the window, and enter Submitted or Approved.

If you have the complete version of Goldenseal, you can bill for projects,
using the estimate amount for draw schedule payments or progress
payments. See the Accounting manual for more about project billing.

If the estimate results in a project that you will do, create a Customer
account and a Project account (see Lesson 9), and enter the estimate into
the Estimate field in the project. Goldenseal uses the estimate price in the
project, and automatically marks the estimate as Awarded.

Estimates in SalesIf the estimate is a budget for general business expenses, enter it into an
Overhead account. For smaller jobs that don’t need detailed job costing or project billing, you

can use a Sale to handle billing for the work in an estimate.If the estimate is a budget for a spec house, or for maintenance on a rental
property, enter it into a Real Estate account. NOTE : Sales are not included in some versions of Goldenseal.
If the estimate is not needed, change its status to Void, or delete it. To include an estimate in a sale, follow these steps:

Locked Estimates
1. Choose Sales from the Income menu.
2. Click the New button.

Once an estimate has been awarded, it is ‘locked’ and you can no longer
make changes to it that affect its price. To change the price of an awarded
estimate, follow these steps:

3. Enter the customer who will pay for the estimated work.
4. Click in the Estimate field, and enter the estimate.
5. Goldenseal will fill in the cost and other information from the

estimate. You can then use the Sale for customer billing and payments.1. Open the Project account that uses this estimate.
2. Remove the estimate from the Estimate field, and hit the Enter key to

save the project.
3. The estimate record will now be editable. Make any changes, and click

Enter to save them.
4. Re-enter the estimate into the Estimate field in the Project.

If you have finalized the price of a project and want to make changes after
you have started work on it, use Change Orders (see page 55).
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Lesson Thirteen: Unit Cost Basics 4. Enter the type of cost this is. Most Cost Items are a material cost, but
they can also be equipment, labor, subcontractor or other costs.

5. If you want to use an optional cost item number, enter it into the Item
Code field. You can use up to four decimal digits.

Goldenseal includes a complete system of unit cost estimating. It may seem
more complicated than doing it by hand, but once you have mastered the
unit costs, you’ll get many advantages for very little work: If 6. Use the clairvoyant field to enter the unit size for this item.

7. Choose a category system, category and optional subcategory.• It’s easy to update prices, when the cost of labor or materials changes.
8. Enter the markup, discount, and pricing details for this item (see the

next section).• You can get a schedule, material takeoff list and contract from your
Estimates with almost no extra work.

9. Click the Vendor Prices button to enter prices from specific vendors.
• Your estimates will be a ‘checklist’ of all possible costs, so you won’t

be as likely to forget things. 10. Click the Inventory Setup button to enter pricing, inventory and
estimating details (see page 79).

•Using Assemblies reduces the amount of math you have to do to make
an estimate, which saves times and reduces the number of errors. 11. Click the Contract Setup button to enter contract details (see page 80).

Price Calculations

When to Use Cost Items When you create cost items, you set up the way that the net cost of the item
is calculated. Goldenseal automatically calculates five different prices for
each cost item:Create a cost item for each type of material that you use frequently—

whether you resell it, build it into projects, use it as a component for
manufacturing, or consume it as part of your overhead costs. Resale— For items sold through a Sale transaction (see Lesson 40).

Reduced— For items sold through a Sale transaction, when the item has
been marked as ‘on sale’.Also create cost items for equipment and employee hours, and for subcon-

tracted labor or services that you use frequently. Project— For items used directly in a project estimate.
For example, create a cost item for any of the following: Component— For items included as a component in an Assembly.

Inventory— For the value of the item while it’s in inventory.• Materials you purchase for use in projects.
The net price for each cost item is calculated from its purchase price and a
Markup System (which adds ‘markup’ to the purchase price).

• Goods that you purchase for resale.
• Office supplies you use frequently.
• Hours of employee labor for each class of employee.
• Hours of equipment time for each equipment type you use.
• Hours of subcontractor time or subcontracted ‘piece work’.

Creating a Cost Item
To create a new cost item, follow these steps:

1. Choose Cost Items from the Details menu.
2. Click the New button.
3. Enter a short name to use in menus, and a more complete name for use

in lists and reports.
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Lesson Fourteen: Updating Prices Net Cost of Labor
When you calculate labor costs, start with an “average” wage rate for an
employee or subcontractor who does that type of work. You can use local
“prevailing wage” figures, or take an average of your employee wage rates
for a particular type of work, or estimate the average wage rate with some
other method.

This lesson explains how to keep your estimating prices up-to-date.

When to Update Prices
Update prices when you have spare time, when prices change dramatically,
or when you need to include something brand new in an estimate.

The net cost of labor is the wage rate plus any employer costs that are
based on payroll (sometimes known as “burden”). You can calculate that
from the actual taxes, insurance and benefits that you pay.

Inflation Adjustments For example, in the US you might use the following calculation:
If you are using prices that are not current, you can add a quick inflation
adjustment to your estimates. To do so, follow these steps:

1. Start with the average wage rate— say $10.00 per hour.
2. Add paid holidays— 6 days / 180 days worked, or .33

1. Open an estimate with a item breakdown. 3. Add paid vacations— 10 days / 180 days worked, or .56
2. Click in the bottom row, and hit the Return key to add a new row. 4. Add the three numbers above to get the net wage per hour actually

worked— $10.893. Click in the Cost Area cell, and enter Percent of Hard, Percent of
Labor or Percent of Materials. Once you have a net wage, add employer taxes and employer benefit

expenses to get the total cost of labor. For example:4. Click in the Cost Item cell, and label the item “inflation” or something
similar. 1. Add the employer portion of FICA— currently 7.65%, or .83

5. Click in the Quantity cell, and type in a percentage adjustment. 2. Add state unemployment tax (SUTA)— 3%, or .33

Updating Labor Prices
3. Add federal unemployment tax (FUTA)— .8%, or .09
4. Add worker’s comp— 12%, or 1.31

Most Assemblies include some labor components. When wage rates,
employer tax rates or payroll insurance rates change, follow these steps:

5. Add disability insurance— 1/2%, or .05
6. Add health insurance— $350 per month / 150 hours worked per

month, or 2.331. Choose Cost Items from the Details menu.
7. Net cost of labor is the net wage plus ‘burden’ = $15.832. Locate items that have Labor for a cost area.

HINT: Your rates will probably be different for SUTA, worker’s
comp and disability insurance. Tax rates may change with time. Your
location may have other employer taxes, and you may need to
include other benefits.

HINT: You can use the Find command to quickly locate all labor
items (see Lesson 16).

3. Calculate the net cost of this type of labor (see page 87).
4. Enter the new rate into the Purchase Price field.

You can also include overhead costs per labor hour, to cover supervision or
payroll labor. Or you can leave them out of the labor rate and cover those
overhead costs via markup or some other method.

5. Hit the Enter key to close the transaction. Goldenseal will
automatically update all Assemblies that use this labor rate.

6. Repeat steps 3 to 5 for each labor cost that has changed.
HINT: Set up a spreadsheet with your calculations. That way you can
check your figures more easily, and it will be less trouble to do the
computation again, the next time taxes or wage rates change.

NOTE: When you change labor prices, Goldenseal will not update
estimates that you have already started. If you want to use current
prices in an existing estimate, open it and click the Update Prices
button.
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Updating Material Prices 5. Enter the supplier who is giving you the price quote.
6 Click in the first row of the breakdown table, and enter prices for one

item.
If you use the full version of Goldenseal, you can update material costs
automatically by entering Material Purchases for the materials you buy, and
using an Item breakdown for them (see Lesson 34). Goldenseal will update
the price of the listed materials, and also use the figures for accounts
payable, inventory tracking and time and materials billing.

7. Hit the Enter key to add a row, and enter additional prices.
8. When you save the record, Goldenseal will automatically update all

unit costs that use the items you purchased.
NOTE: When you change material prices, Goldenseal will not update
estimates that you have already started. If you want to use current
prices in an existing estimate, open it and click the Update Prices
button.

You can also enter price quotes, whether you use the full Goldenseal or just
the estimating version. To do so, first set up material accounts, as follows:

1. Choose Material Suppliers from the Details menu.
2. Click the New button.

Updating Cost Items
3. Enter details for one of your material suppliers.
4. Repeat steps 2 and 3 for each supplier who gives you price quotes.

To set the way a Cost Item updates, follow these steps:Next, you can enter prices from each supplier, as follows:
1. Choose Cost Items from the Details menu.1. Choose Material Purchases from the Details menu.
2. Find the desired Cost Item.2. Click the New button.
3. Enter a method into the Pricing Method field. You can use the most

recent price, or an average price (see page 76). You can also type a
price in directly, and not use purchases at all.

3. Enter Pricing Only into the Status field on the left side of the window.
4. Enter Items into the Breakdown field on the left side of the window.

Calibrating Unit Prices
If your business depends on cost estimates, then you probably want them
to be accurate. Here are some ways you can make that happen, both when
you first start out with Goldenseal, and as you use the program over the
years.

Trial Estimates
If you’ve never used Goldenseal before, start out by making a ‘trial’
estimate on a project that you’ve completed that has accurate job cost
data. If you don’t have good job cost data for any projects, you might want
to pick one or two of them, and enter expenses for them into Goldenseal so
you know what the actual costs were.

When you make a trial estimate, the goal is to get it to hit actual costs ‘on
the nose’. You can do that be adjusting unit costs, or by figuring a ‘fudge
factor’ that you enter as a quick adjustment percentage (see page 86).

You may even want to make several trial estimates. It’s a good way to get
familiar with Goldenseal, and also get familiar with the unit costs.
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If you haven’t completed any projects or don’t have accurate job cost data,
you can still calibrate prices by comparing a Goldenseal estimate with an
estimate that you prepare by hand. Use whatever method you’ve used for
past estimates, and take extra time to make sure it is complete and
accurate, so Goldenseal will start out more accurate too.

Adding Assemblies
Sometimes an estimate is off because you didn’t include the correct items in
the original estimate. The best way to fix that is to set up templates for
your most common types of work (see Lesson 24).

As you finish each project, check the actual expenses against the original
estimate. If you need to change items in the estimate to make it more
accurate, also change them in the template. That way your future estimates
will include the correct items.

Job Cost Feedback
It’s a very good idea to track expenses on all of your projects, so you can
see how accurate each estimate turns out to be. The Job Costs command
compare ‘estimated versus actual’, so it is easy to get that feedback.

Templates are a good way to store the ‘business smarts’ of your business.
That way you won’t have to think so hard when you make estimates, and
you’ll be more likely to include just what you need.When each project is complete, take a look at each general cost category,

and check how actual costs compared to the original estimate.

Adjusting OverheadFor those categories that are significantly off, it’s a good idea to double-
check the actual expense records, to make sure there wasn’t a mistake. If
the data is good, then adjust the Cost Items and Assemblies that you used
for the project so they are closer to the correct amount.

The full version of Goldenseal lets you track overhead expenses. You can
recoup those expenses via markup (see page 77), or you can add an
overhead line item to estimates (see page 24).

Individual projects sometimes have ‘quirks’, so it’s a good idea to track
costs on every project you do. That way over time you can perfect your
costs and get very accurate estimates. Turtle Creek Construction was able
to consistently bid within 2% of actual costs after we computerized, and
many users of our software have reported similar accuracy. Bidding is more
fun when it’s not a gamble!

Updating Estimates
When you change prices, Goldenseal does not update estimates that you
have already started.

To update prices in an existing estimate, follow these steps:

Changing Assemblies
1. Choose Estimates from the Estimates menu.
2. Find the desired estimate.

If an assembly is not giving you accurate estimates, you can adjust it in
several different ways:

3. Click the Update Prices button.

Finishing Up• If the overall quantity is off, change the Suggested Quantity for the
item (see page 79), or change the way the dimension is calculated.

You now know how to keep prices accurate in Goldenseal.• If material costs are off, change the waste factor for some components,
change the quantities of the material components, or change the
specific components that are included in the Assembly.

Have you ever considered using the futures markets to hedge your pricing
on upcoming purchases?

• If labor costs are off, change the number of person-hours. The Chicago Ornamentals Exchange allows you to ‘lock in’ prices for future
deliveries of lawn flamingos, gargoyles, gnomes and other landscaping
essentials. With luck, your investment in 1000 brass gargoyles for December
delivery may appreciate handsomely, and allow you to sell out at a profit.

• If you are using an Assembly to estimate work done by a
subcontractor, you can adjust either the labor components, the
material components, or both. You don’t need to know exact details
of what the subcontractor uses— just get the cost of the ‘trial
estimate’ to match what the subcontractor actually charged you.
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Lesson Fifteen: Schedules Adding Delays
To add a delay in the middle of a project, follow these steps:

Goldenseal calculates schedule dates for each estimate that has a category
or item breakdown. This lesson explains how to use the scheduling features.

1. Click in the bottom row, and hit the Return key to add a new row.
2. Click in the Cost Area column, and enter Delay.

Project Start Date
3. Click in the Size column, and enter Hours or Days.
4. Click in the Quantity column, and enter the amount of delay.

To enter the start date for work on an estimate, click in the Start Date field
and type in a date. If you have already entered items and want to update
the schedule, click the Update Schedule button.

5. Drag the row to its final place in the schedule (see the next section).

Changing Schedule Order

Item Start Dates
To change the order of items in an estimate, follow these steps:

1. Hold down the Control key, and click the row that you’d like to move.
As you enter each item into an Estimate breakdown, Goldenseal computes
the time it takes to do that item, and adjusts the start date for all following
items. It also adjusts the Finish Date for the entire estimate.

2. Keep holding the mouse button down, and drag to the new location.
3. Lift up the mouse button. Goldenseal will move the row.
4. Repeat steps 1 to 3 for any other items you’d like to move.
5. When you are finished, click the Update Schedule button to

recalculate the entire schedule.

Changing Schedule Columns
You can use the Custom Layouts command (Lesson 21) to add more
scheduling fields to the estimate breakdown tables. You can add columns
to show start time, finish date and finish time (see page 138).

You can also add start time and finish time fields to the estimate itself, if
your projects don’t take very long (see page 129).

If the item is an assembly, Goldenseal calculates the time it will take for
each component in the assembly, and multiplies that total by the quantity.

For labor items, Goldenseal divides the total person-hours for the item by
the crew size in the Crew column.

Crew Size
To change the crew size for any item, click in the Crew column and type in
a different number. Goldenseal will automatically adjust the start date for
every item after the changed line.
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Working Hours
Exporting SchedulesGoldenseal lets you base schedules on the hours that you actually work.

Goldenseal currently does not create Gannt charts, or ‘bar charts’ for a
schedule. However, you can export the calculated data out of Goldenseal,
and then import it into other scheduling programs.

To set up working hours, follow these steps:

1. Choose Costs Setup from the Costs menu, and choose Working Hours
from the submenu.

To export a schedule, click the Export Schedule button. It will save a text
file on your hard drive at whatever location you select. You can then import
that file into your favorite Gannt chart program.

2. You’ll see a list of Working Hours. Double-click on an item in the list.
3. You’ll see details for this set of working hours.
4. Enter the vacation schedule, and the hours your crew works each day.

You can also enter a delay factor to adjust all schedule dates.

Finishing Up
In this lesson you’ve learned how to use the schedule dates in an estimate.

This might be a good time to figure the installation time for each wax cherry
or banana in the chic hat that you started in Lesson 4,. You wouldn’t want
to make social plans, and then not have it ready in time!

When Goldenseal calculates the schedule with these hours, it will only
schedule work during the working hours, and it will skip any holidays
included in the vacation package.

If you don’t use Working Hours, Goldenseal uses a normal work week and
spreads it out over the entire week.

Schedule Reports
To see a printed schedule, choose Projects from the Reports menu, and
choose Schedule from the submenu. You’ll see a listing of tasks, with the
start and end dates for each (see page 117).
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Lesson Sixteen: Bill of Materials
Goldenseal includes two reports which show a list of materials that you’ll
need to purchase for a project (called a bill of materials or a material
takeoff). In the reports, Goldenseal calculates material quantities for each
estimate item, using components from an Assembly (see Lesson 14).

NOTE: Some people use the term ‘takeoffs’ for the measurements that
you make when starting an estimate (see Lesson 4). With Goldenseal,
you don’t need to calculate the actual quantities of materials when you
make an estimate, since the unit costs do that automatically .

Setup
To get a bill of materials, first create Assemblies for the work that you do
on projects (see Lesson 14). Assemblies contain info about the exact
material that you need to include in each piece of work that you do.

HINT: Goldenseal includes Starter Files which already contain Cost
Items and Assemblies for different businesses (see page 159). You may
be able to find one that includes some or all of the work that you do, so
you don’t need to spend so much time setting up assemblies.

When you are ready to start a project, create an Estimate for it, and give
the estimate an Item breakdown (see page 22). Fill in each item of work that
will be part of the project. 5. You can print the list, or save it as a text file so you can open it with a

word processor or spreadsheet (see page 120).
HINT: Create an estimate even if you are just doing the work for
yourself. That way you’ll have a budget, and you can create material
takeoffs for the items you need to purchase.

HINT: The takeoff shows ‘theoretical’ quantities. You should check
it, and make adjustments for any special conditions that you know
about. You may also need to round fractions to whole numbers!

Bill of Materials (Material Takeoff) Report Bill of Materials by Task
To see an overall list of materials for a project, follow these steps: To get the materials for each line item in an estimate, follow these steps:

1. Choose Estimates from the Reports menu, and choose Bill of Materials
from the submenu.

1. Choose Estimates from the Reports menu, and choose Bill of Materials
by Task from the submenu.

2. Enter an estimate into the Estimate field. 2. Enter an estimate into the Estimate field.
3. Click the Update button. 3. Click the Update button.
4. You’ll see a list of materials for the project. The Gross Quantity

column shows the calculated quantity, and the Net Quantity column
shows the quantity including a waste factor.

4. You’ll see a list of materials for the project, itemized by line item from
the estimate.
HINT: The ‘by item’ report is useful for allocating materials to
different locations in a project.
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Lesson Seventeen: Custom
Dimensions

Goldenseal lets you create your own dimensions, if there isn’t a Starter File
that suits your estimating needs. You can also make changes to an existing
set of dimensions.

The four classes of dimensions calculators provide the logic that converts
simple project measurements into actual quantities of labor and materials.

Basic Dimensions
Basic dimensions are simple measurements that you type in for each
estimate. To create a new basic dimension, follow these steps:

1. Choose Calculations from the Options menu, and choose Basic
Dimensions from the submenu.

2. You’ll see a list of dimensions. Click the New button.

Partial Takeoffs
For either takeoff report, you can list just those materials needed during a
certain time period. To do so, follow these steps:

1. Click the More Details button.
2. Click on the Date Range popup, and choose a date range.
3. Click the Update button.

HINT: For more about reports, see Lesson 20.

Finishing Up
3. Enter a brief name and description for the dimension.
4. Enter the type of display to use for this dimension. You can show an

integer (no decimals), a money value, a number or a percentage. You
can also show a checkbox (with true and false values), or a popup list
of up to six values (enter the choices into the List Items field).

In this lesson you’ve learned how to get bill of materials reports from an
estimate.

Of course it goes without saying that a detailed material list is just what
you need when assembling complex projects such as a chic Carmen
Miranda hat. You’ll never under-order on wax pineapples again!

5. Enter a suggested quantity. When you make an estimate, the
dimension will start out with this value.

6. Enter the unit size to use for this measurement.
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Location Dimensions
Location dimensions are very similar to basic dimensions, but they apply to
each location in an estimate. For example, in the Sample Company File,
location dimensions apply to each room in a construction project.

To enter location dimensions, follow these steps:

1. Choose Calculations from the Options menu, and choose Basic
Dimensions from the submenu.

2. You’ll see a list of location dimensions. Click the New button.
3. Enter the same information as for basic dimensions (see page 141).

You will fill in location dimensions for each location when you add
locations to an estimate (see page 29).

Calculated Locations
Calculated locations are quantities that are calculated from other
measurements within the same location. They only apply to one location.

To enter calculated locations, follow these steps: When you add locations to an estimate (see page 29), Goldenseal will
calculate the value of each calculated location.1. Choose Calculations from the Options menu, and choose Calculated

Locations from the submenu. HINT: If you start with a Starter File (see page 159), you’ll already have
a set of dimensions, and you may not need to make many changes to
them to match your type of business. If there is no Starter File for your
type of business, contact Turtle Creek— we offer free customizing help.

2. You’ll see a list of location calculations. Click the New button.
3. Enter a brief name and description.
4. Enter a dimension into the Starts With field. You can bases this item

on a regular location dimension, or on another calculated location.
5. Enter adjustments. If the Starts With dimension is a popup list, enter

a value that will be used for each of the six possible values in the
popup field. If the Starts With dimension is a checkbox, enter a value
for each of the two possible values for the checkbox. For other
dimensions, you can add, subtract, multiply or do other math.

6. Enter the way you’d like to round this calculated value.
7. Turn on the Value Can be Changed checkbox if you’d like to be able to

replace the calculated value with a value that you type in.
8. Turn on the Don’t Show in Layout checkbox if you’d like this

calculation to be ‘invisible’.
9. Turn on the Allow Negative Values checkbox if negative values would

make sense here.
10. If this calculation is already used in a layout, Goldenseal shows you

some details about how it’s used.
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Calculated Dimensions 8. Turn on the Don’t Show in Layout checkbox if you’d like this
calculation to be ‘invisible’.Calculated dimensions calculate a value from any type of dimensions, or

from other calculated dimensions. 9. Turn on the Allow Negative Values checkbox if negative values would
make sense here.

HINT: The Sample Company file includes several hundred Calculated
Dimensions that convert simple project measurements into construction
quantities like baseboard length.

10. If this calculation is already used in a layout, Goldenseal shows you
some details about how it’s used.

List and Checkbox CalculationsTo enter calculated dimensions, follow these steps:

1. Choose Calculations from the Options menu, and choose Basic
Dimensions from the submenu.

If you enter a list dimension into the Starts With field, Goldenseal will show
six values, which correspond to each of the six possible items in the list. For
each choice, you can enter a constant number, a dimension value, or a
calculated dimension.

2. You’ll see a list of location dimensions. Click the New button.

EXAMPLE: If the dimension in the Starts With field has the second item
selected, the value of this calculated dimension will be equal to
whatever you’ve entered into the ‘2nd Adjustment’ fields.

If you enter a checkbox dimension into the Starts With field, Goldenseal
shows two values, which correspond to the ‘on’ and ‘off’ values for the
checkbox. For each choice you can enter a constant number, a dimension
value, or a calculated dimension.

Dimension Layouts
Use Dimension layouts to control what you see on the screen when you
choose dimensions in an estimate.

To change the location dimensions layout, choose Custom Layouts from the
Options menu, and choose Location Dimensions from the submenu. There
is only one location dimension layout.

To enter dimension layouts, follow these steps:
3. Enter a brief name and description for this calculation. 1. Choose Custom Layouts from the Options menu, and choose Estimate

Dimensions from the submenu.4. Enter a dimension value into the Starts With field. You can use a basic
dimension or another calculated dimension. You can also use a
location dimension, and get the total value from all the locations that
have been entered into the current estimate.

2. You’ll see a custom layout for dimensions that is similar to other
custom layouts (see Lesson 21). Click on the Layout popup at upper
left to switch to a different dimension.

5. Enter up to six adjustments to the start value. You can add, subtract
or multiply, or do other math. 3. You can add fields, change the position of items, and otherwise

change the contents of the layout.
6. Enter the way you’d like to round this calculated value. 4. To create new dimensions, choose New Layout from the Edit menu.

You can also delete or rename existing layouts.7. Turn on the Value Can be Changed checkbox if you’d like to be able to
replace the calculated value with a value that you type in.
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Using Dimensions
To use a dimension, enter it into the Suggested Quantity field in a Cost Item
(see Lesson 13) or an Assembly (see Lesson 14). The Suggested Quantity
field determines the quantity for each item when you first enter it into an
item breakdown, or when you click the Update Quantities button.

You can also use dimensions in the Labor Multiplier and Material Multiplier
fields to adjust just some of the components in an Assembly.

Once you’ve set up dimension calculators in cost items and assemblies, the
dimension will automatically apply when you include those items in an
estimate that has an item breakdown.

Some dimension quantities are easy to calculate, and don’t vary much
between projects. You might want to double-check them the first few times
you use them, but you can then trust them to be accurate.

Other dimension quantities are guesses, and the actual quantity will vary
between projects. You can use the suggested number for quick rough
estimates, but for accurate bids you’ll need to adjust them every time.

Finishing Up
This lesson has explained how to set up dimension calculators.

Dimensions are a good way to store ‘business smarts’. They often make it
possible for a relatively inexperienced estimator to create an accurate
estimate very quickly.

Were you thinking of taking a break now? How could you? There are just
two lessons to go, and you couldn’t possibly want to leave. No matter how
tempting those yummy leftovers in the fridge might be, and how many
overdue videos you have, it is time to move onto the next lesson. Briskly.

Don’t even think about chocolate, or ice cream. Not to mention the double-
chocolate ice cream that is just overflowing from the freezer shelves at your
local convenience store, just down the block. It may even be on sale. They
may even be giving away free samples today.

Stay!
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